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Preface 
This document explains the procedure of the installation and the Confirmation of RFID Label Design 

and Encoding Management Pro (Hereafter, it is written, "This tool"). Be sure to read this document 

before using this tool. 

 

 Please read the First Step Guide first. 

 

 Abbreviations and generic terms used in documents for Fujitsu RFID Integrated 

Label Solution 

The documents use the following abbreviations and generic terms. 

Name Abbreviation used in this document 

Microsoft® Windows® 7 Professional Windows 7 

Microsoft® Windows® 8.1 Professional “Windows 8.1” 

Microsoft® Windows® 10 Professional “Windows 10” 

Terminals where Windows 7, Windows 8.1, or 

Windows 10 has been installed 

Personal computer 

PC 

Reader device for 2D barcode “2D reader” 

Reader/writer devices "Reader device" 

RFID tags Tag 

Fujitsu’s RFID Integrated Label – 8Kbyte 

(Large/Medium/Small) 

"Large capacity RFID tag" or "high memory 

tag" 

Fujitsu’s RFID Integrated Label – 1Kbyte 

(Large/Medium/Small) 

Fujitsu's 2-kilobit RFID tags 

Tag 

 Trademarks 

Microsoft, Windows, .NET Framework, and .NET Compact Framework are registered 

trademarks of Microsoft Corporation in the United States and other countries.  

Other company names and product names in this document are trademarks or registered 

trademarks of respective companies. Note that system names and product names in this 

document are not always followed by trademark symbols such as ® or ™. 

 

 ATA (Air Transport Association of America) Spec 2000 Chapter 9-5 

This tool is designed to read and write data from and to tags in compliance with the 

specification for Radio Frequency Identification (RFID) on Parts in ATA Spec2000 Chapter 9-5. 
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 High Risk Activity 

This product is designed and manufactured as contemplated for general use, including 

without limitation, general office use, personal use and household use, but is not designed and 

manufactured as contemplated for use accompanying fatal risks or dangers that, unless 

extremely high safety is secured, could lead directly to death, personal injury, severe physical 

damage or other loss (hereinafter called "High Safety Required Use"), including without 

limitation, nuclear reaction control, aircraft flight control, air traffic control, mass transport 

control, life support, and weapon launch control . The customer shall not use this product 

without securing the sufficient safety required for the High Safety Required Use. 

 

 Notes on export procedures 

When exporting or providing this product and this document, check the regulations under the 

Foreign Exchange and Foreign Trade Law and the laws and regulations relating to US export 

control, and complete the necessary procedures. 

 

 Screenshots and illustrations 

The screenshots and illustrations in this document are only examples, and the actual screens 

may be slightly different depending on the environment that you are using. 

The screenshots used in the explanations in this document are from a Windows 7 

environment. 



 Other Notes 

No part of this document may be reproduced or reused for other purposes without the 

express written permission of Fujitsu Limited. 

The content of this document may change without prior notice. 
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

 Revision history 

Edition Date issued Changes 

Version 

1.00 
June 2014 Initial version released. 

Version 

1.10 
March 2015 Support for Windows 8.1 

Version 

1.11 
June 2015 Installation procedure changed. 

Version 

1.20 
September 2015 Add Commissioning from 2D and Batch Commissioning  

Version 

1.21 
October 2015 Small changes. 

Version 

1.22 
January 2016 Changes for LAN connection with ZXP-7 

Version 

1.23 
October 2016 For the first enhancement in 2016 

Version 

1.30 
March 31 2017 Enhancement for ATA Spec 2000 Rev.2016 support. 

Version 

1.31 
May 17 2017 Enhancement for Integrated Label Slim support. 
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1 Overview 

1.1 Product Overview 

RFID Label Design and Encoding Management Pro can initialize RFID tags in the ATA formats 

specified in ATA Spec2000 Chapter 9-5, and print the label on RFID tags by RFID printer. This 

tool consists of the following 5 applications. 

 

Name Description 

Label Designing This application is for label designing and printing for RFID 

tags. 

Commissioning by Barcode 

Scanning 

This application enables to create commission data by 

scanning barcode which contains the search key. After 

scanning barcode, this application automatically searches 

and extracts a data record from a database, and sets it as 

commission data. 

Batch Commissioning This application extracts multiple data records by search key 

from a database and creates commission data for multiple 

tags one time. 

Commissioning from 

Integrated Sources 

The commission does one tag to this application. The input 

method is a hand input or a database input or fixed value 

input. 

Manual Input This application creates commission data based on the data 

input by manual or CSV/XML file. 

 

This document explains the procedure to install the above applications. Please refer to the each 

user manual for the application details and the usage. 

 

Manual title Description 

Getting Started with the BarTender 

Application Suite 

Explains how to use the Label Desining function of 

“RFID Label Design and Encoding Management Pro”. 

RFID Label Design and Encoding 

Management Pro User's Guide 

(Commissioning by Barcode 

Scanning) 

• Explains how to use the Commissioning by Barcode 

Scanning application of “RFID Label Design and 

Encoding Management Pro”. 
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Manual title Description 

RFID Label Design and Encoding 

Management Pro User's Guide 

(Commissioning from Integrated 

Sources) 

• Explains how to use the Commissioning from 

Integrated Source application of “RFID Label Design 

and Encoding Management Pro”. 

RFID Label Design and Encoding 

Management Pro User's Guide 

(Batch Commissioning) 

• This is the present document 

• Explains how to use the Batch Commissioning 

application of “RFID Label Design and Encoding 

Management Pro”. 

RFID Label Design and Encoding 

Management Pro User's Guide 

(Manual Input) 

• Explains how to use the Manual Input application of 

“RFID Label Design and Encoding Management Pro”. 
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1.2 Installation Prerequisites 

The following hardware and settings are required to install and use this tool. 

1.2.1 PC 

1.2.1.1  Hardware Requirements 

Hardware Description 

CPU A CPU with a 1.0 GHz processor or higher (manufactured by Intel 

or AMD) 

Memory 1 GB or more 

Hard disk capacity 400 MB or more 

Text resolution 96 DPI 

Display size XGA (1024 x 768) or higher 

 

 Reference: ・Administrator rights on the PC are necessary to install this tool. 

 

1.2.1.2 Software Requirements 

 Windows 7 Professional Service Pack 1 (64-bit edition), Windows 8.1 Professional (64-bit 

edition), or Windows 10 Professional (64-bit edition) 

 .NET Framework 3.5 

 .NET Framework 4.5.1 or the compatible version 

 Microsoft Office 2010 or later (every edition) Access and Excel 

 SEAGULL BarTender Enterprise Automation 10.1 Software (provided with the CD) 

 ZXP7ToolsSetup.exe Software (provided with the CD) 

 ZEBRA_7.4.3 Printer Driver (provided with the CD) 

 RFID Label Design and Encoding Management Pro Software (provided with the CD)  

 

 Reference: ・Both .NET versions 3.5 and 4.5.1 (or the compatible version) need to be 

installed on the PC. 

・.NET Framework 3.5 is preinstalled on Windows 7. 

・.NET Framework 4.5.1 or the compatible version is preinstalled on Windows 

8.1, Windows 10. 

 



-4- 
Copyright© FUJITSU LIMITED 2017 

1.2.2 RFID Tags 

This tool supports the following RFID Tags 

 Fujitsu’s RFID Integrated Label – 1KByte Large 

 Fujitsu’s RFID Integrated Label – 1KByte Medium 

 Fujitsu’s RFID Integrated Label – 1KByte Small 

 Fujitsu’s RFID Integrated Label – 8KByte Large 

 Fujitsu’s RFID Integrated Label – 8KByte Medium 

 Fujitsu’s RFID Integrated Label – 8KByte Small 

 Fujitsu’s RFID Integrated Label Slim – 2Kbit 

 

1.2.3 RFID Printer 

(1) RFID printer for Fujitsu’s RFID Integrated Label 1Kbyte/8Kbyte 

Manufacturer Type Model 

Zebra Technologies Card Printers (UHF) ZXP Series 7 Card Printers (UHF) 

 

 

(2) RFID printer for Fujitsu’s RFID Integrated Label Slim – 2Kbit 

Recommended label printer is Zebra Technologies’ ZT410R (300dpi). 

 



 

-5- 
Copyright© FUJITSU LIMITED 2017 

1.3 Quick Installation Guide 

The following shows the overview of installation operations. 

(1) Log in to the PC (as Administrator or with admin rights). 

(2) Install the BarTender Software and the Seagull Licensing Server. 

(3) Install the printer driver for ZXP-7 printer. 

i. Run the “ZXP7ToolsSetup.exe” to install the ZXP-7 Tools.. 

ii. Connect the printer via USB or LAN cable to the PC and power on the printer 

iii. Run the “Zebra_n.n.n.exe” to install the ZXP-7 Driver. 

iv. Set up the Zebra ZXP Series via the printer preferences and properties. 

(4) Run the “Setup.exe” to install the RFID Label Design and Encoding Mannagement Pro 

Software. 

 

! Caution • It is necessary to use a label printer in order to use “Fujitsu’s RFID Integrated 

Label Slim – 2Kbit”. In that case, it is necessary to setup the label printer 

instead of "(3) Install the printer driver for ZXP-7 printer". 
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2 BarTender Installation  

First, please install BarTender which is one of components of Fujitsu Label Design and Encoding 

Management Pro. This application includes label design and print function for RFID Integrated Labels.  

2.1 Pre-installation Planning 

Before you start installation, you will need to decide which PC to install BarTender on. Necessary 

software for using the BarTender is as below.  

 

 In the case of installing BarTender on a single computer: it is necessary to install both 

BarTender and Seagull Licensing Server on the same computer (please refer to the 2.2 Install 

the BarTender on a single computer). 

 

 Reference: ・The Seagull License Server application is installed together with the 

BarTender Software automatically. 

 

 Adding BarTender on multiple computers: at first install both BarTender and Seagull 

Licensing Server on a single computer on a network. (please refer to the 2.2 Installing the 

BarTender on a single computer) Then, install only BarTender on other computers (please refer 

to 2.3 Add the BarTender on multiple computers for the operating procedure). 

 

 Reference: ・Please refer to Getting Started with the BarTender Application Suite for 

more details about Seagull License Server. 

 

! Caution • To refer to the manual of BarTender, the following Files on the RFID Label 

Design and Encoding Management Pro CD are started. 

\Seagull BarTender10.1\StartMenu\main.html 

• The reference of the manual can be done by clicking Link of "Getting 

Started" Manuals" that exists in the menu. 
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2.2 Install the BarTender on a single computer 

 Operating procedure 

(1) Turn on the PC where this tool is to be installed and log in as either the PC administrator 

or a member of the Administrators group. 

(2) Insert the RFID Label Design and Encoding Management Pro CD into your computer’s 

CD drive.  

(3) Open the “\Seagull BarTender10.1\BT32” folder of the CD using Explorer and double 

click the "setup.exe”. 

 

! Caution • If the PC does not have a CD drive, use another PC to copy the content of 

the “\Seagull BarTender10.1\BT32” folder on the CD to USB memory (or a 

similar device), and then execute "setup.exe" from there. 

 

(4) Select the language and click the OK button. 
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(5) Click the Next button. 

 

 

(6) Check “I accept the terms in the license agreement” and click the Next button. 
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(7) Select “Enterprise Automation” and click the Next button. 

 

 

(8) Check “Seagull License Server” and click the Next button. 

 

 

 Reference: ・In this case (for a single computer) the License Server need to be installed 

on the PC the RFID Label Design Software is installed and the ZXP7 Printer 

is connected to. 
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(9) Click the Next button. 

 

 

(10) Click the Install button. 
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(11) The installation of the BarTender will start. 

It takes a few minutes to install. Please wait until Installation to be completed. 

 

 

(12) After the installation is completed, click the Activate Now… button. 

 

 

 Reference: • It is also possible to activate it via Internet. 
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(13) Enter the product key and click the Next button. 

 

 

(14) Check “I Agree” and click the Next button. 

 

**** **** **** **** 
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(15) Select your country and click the Next button. 

 

 

(16) Click the Next button. 
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! Caution • Need Internet access for this activation process. 

• If Internet access is not available on the computer, please do another 

activation method according to the instructions on the installation wizard. 

 

(17) Click the Finish button. 

 

 

This completes the installation procedure for the BarTender and the Seagull Licensing Server. 
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2.3 Add the BarTender on multiple computers 

If you want to additionally install BarTender on multiple computers, please continue the 

following operations and install only BarTender on other computers. Otherwise, please skip to 

Section 3 ZXP-7 Driver Installation.  

 

 Operating procedure 

(1) Prepare other computers and log in as either the PC administrator or a member of the 

Administrators group. 

(2) Insert the BarTender CD into your computer’s CD drive.  

(3) Open the “\Seagull BarTender10.1\BT32” folder of the CD using Explorer and double 

click the "setup.exe”. 

 

! Caution • If the PC does not have a CD drive, use another PC to copy the content of 

the “\Seagull BarTender10.1\BT32” folder on the CD to USB memory (or a 

similar device), and then execute "setup.exe" from there. 

 

(4) Select the language and click the OK button. 
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(5) Click the Next button. 
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(6) Check “I accept the terms in the license agreement” and click the Next button. 

 

 

(7) Select “Enterprise Automation” and click the Next button. 
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(8) Click the Next button. 

 

 

! Caution • Please do not check “Seagull License Server” when installing only the 

BarTender copy. 
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(9) Click the Next button. 

 

 

(10) Click the Install button. 
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(11) The installation of the BarTender will start. 

 

 

(12) After the installation is completed, check the “Run BarTender” and click the Finish 

button. 
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(13) The BarTender application will start up. Click the Close button. 

 

 

(14) Select “Licensing setup” in “Administer” menu. 
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(15) Enter the IP address of the Seagull Licensing Server and click the OK button. 

 

 

! Caution • Need TCP/IP connectivity with the Seagull Licensing Server for this 

activation process. 

 

(16) Select “About…” in the “Help” menu. 

 

***.***.***.*** 
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(17) Check the Activation Status is “Activated” and click the OK button. 

 

 

This completes the installation procedure for the BarTender. 
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3 Set up Printer 

3.1 ZXP-7 

3.1.1 Install the ZXP-7 Tools 

 

 Operating procedure 

(1) Open the root folder of the CD using Explorer, and then double-click the 

"ZXP7ToolsSetup.exe”. 

 

 

(2) If the following warning dialog box is displayed, click the Yes button. 

 

 

 

 Reference: • Please click the Yes button similarly if the warning dialog box is displayed at 

the following. 
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(3) Click the Next button. 

 

 

(4) Select “I accept the terms in the license agreement” and then click the Next button. 

 

 

(5) Click the Install button. 
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(6) The installation of this driver will start. 

 

 

 

 Reference: • Please click the Install button if the following screen is displayed. 

 

• Please click the Close button if the following screen is displayed. 
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(7) Select Command Prompt Window, press “Enter” key. 

 

 

(8) Select “FTDIChip CDM Drivers” Window, click the Extract button. 

 

 

! Caution • If you do not see above screen then because it is direct behind the Device 

Driver Installation Wizard. In this case please move the away (don’t close) 

the Wizard to another place or click on the icon in the task bar 
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(9) Click the Next button. 

 

 

(10) The installation of this driver will start. 
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(11) Click the Finish button. 

 

(12) After the installation completes, click the Finish button. 
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3.1.2 Install the ZXP-7 Printer Driver 

There are 2 options to install ZXP-7 printer driver; (1) USB connection and (2) LAN connection. 

Please perform either of 3.1.2.1 Install the ZXP-7 Printer Driver via USB or 3.1.2.2 Install the 

ZXP-7 Printer Driver via LAN. 

 

3.1.2.1 Install the ZXP-7 Printer Driver via USB 

(1) Connect RFID Printer “Zebra ZXP Series 7 (UHF)” with PC using USB cable. 

 

! Caution • The Printer always must be connected to the USB port you have used during 

installation! 

 

(2) The driver of the printer is installed. 

 

 

(3) There is no problem though the installation of the printer driver fails. 

 

 

(4) Double-click the “Zebra_n.n.n.exe” in the Driver folder in the CD. 
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(5) Select “I accept the terms in the license agreement”, click the Next button. 

 

 

(6) Click the Next button. 
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(7) Click the Finish button. 

 

 

 

 

(8) Select “Install printer drivers”, click the Next button. 
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(9) Click the Next button. 

 

 

(10) Click the Next button. 
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(11) Click the Finish button. 

 

 

(12) The installation of this driver will start. 

 

 

(13) Click the “Install”. 
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(14) After the installation completes, click the Close button. 

 



-36- 
Copyright© FUJITSU LIMITED 2017 

 

 

(15) Click the “Devices and Printers” in Start Menu of Windows. 

 

 

(16) Check that ZXP-7 Driver has been successfully installed. 

 

 

This completes the installation procedure for this driver. 
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3.1.2.2 Install the ZXP-7 Printer Driver via LAN 

(1) Connect RFID Printer “Zebra ZXP Series 7 (UHF)” with the network using LAN cable. 

(2) Double-click the “Zebra_n.n.n.exe” in the Driver folder in the CD. 

 

(3) Select “I accept the terms in the license agreement”, click the Next button. 

 

(4) Click the Next button. 
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(5) Click the Finish button. 

 

(6) If the following warning dialog box is displayed, click the Yes button. 

 

(7) Select “Install printer drivers”, click the Next button. 
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(8) Select “Network (Ethernet or WiFi)”, click the Next button. 

 

(9) Select “Zebra ZXP Series 7”, click the Next button. 

 

(10) Click the Create Port… button. 
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(11) Select “Standard TCP/IP Port”, click the New Port… button. 

 

(12) Click the Next button. 

 

(13) Enter the IP address into the “Printer Name or IP Address” box and click the Next 

button. 
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(14) Click the Finish button. 

 

(15) Click the Close button. 

 

(16) Click the Next button. 
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(17) Click the Next button. 

 

(18) Click the Finish button. 

 

(19) After the installation completes, click the Close button. 
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! Caution • If Windows Firewall is enabled on the PC, it is necessary to configure the 

settings to allow inbound connections on the following ports in advance. 

Seagull Driver Port 9100,19540(TCP,UDP) 
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3.1.3 Set up the Printer Preferences 

This section explains the setup procedure for the Zebra ZXP Series 7 (UHF). 

Note: Refer to the ZXP Series 7 manual for details. 

 

 Operating procedure 

(1) Connect ZXP-7 with PC. 

 

 

 

 

 

 

 

 

(2) Open Windows’ Devices and Printers from the Start Menu. 

Right click the driver, and select Printing Preferences 

 

 

(3) Choose the Graphics tab and select ‘K-Black (resin)’ for Ribbon Setup Type, continue 

with the Apply Button 

 

USB or LAN cable 

PC ZXP-7 
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(4) Choose the Stock Tab and select ‘Feeder’ or ‘ATM Slot’ for Card Setting Source and 

confirm settings with the OK button. 

 

 Reference: • Select ‘Feeder’ if using the Feed Cartridge.  

• Select ‘ATM Slot’ if using the Manual Feed Slot. 

 

i) Feed Cartridge (default) 

 

ii) Manual Feed Slot 

 

 

(5) Right click the driver, and select Printer Properties 

 

 

(6) Choose the Tools Tab and click the “Configure”, then select the ‘Smart Card Options’ 

from the pull-down. 
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(7) Select the EPC Gen2 tab. 

 

 

(8) Choose “Lock Permanently” for EPC Memory 

(9) Choose “Lock Permanently” for User Memory. 

(10) Choose “Open” for TID Memory. 

(11) Choose “Lock Permanently” for Access Password. 

(12) Choose “Lock Permanently” for Kill Password. 

(13) Input “00000000” to New Password of Access Password. 
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(14) Click the Range button. 

 

 

(15) Selected “Lock modified blocks when specified” 

Click the OK button. 

 

 

(16) Click the OK button. 
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(17) Click the Tools tab and Select ‘Action’. 

 

 

(18) Click the “Read Printer Information” and click the Close button. 

 

 

(19) Click the OK button to confirm the settings and to close the Window. 
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3.2 Label Printer  

This section explains the setup procedure for the Zebra ZT410 as an example.  

Note: Refer to the ZT410 manual for details. Need to calibrate the position of tags according to the 

manual, before encoding and printing tags. 

 

! Caution • If you use another label printer, please configure equivalent settings 

according to the setup procedure provided by the printer manufacturer or 

supplier. 

 

3.2.1 Setting up the Printer Preferences 

 

 Operating procedure 

(1) Connect ZT410 with PC. 

(2) Open Windows’ Devices and Printers from the Start Menu. 

Right click the driver, and select Printer Properties 
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(3) Choose the Tools Tab and click “Configure”, then select ‘Smart Card Options’ from the 

pull-down. 

 

 

(4) Select the EPC Gen2 tab. 

 

 

(5) Choose “Lock Permanently” for EPC Memory 

(6) Choose “Lock Permanently” for Access Password. 

(7) Choose “Lock Permanently” for Kill Password. 

(8) Input “00000000” to New Password of Access Password. 
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(9) Choose “Lock Permanently” for User Memory. 

Lock settings of User Memory is different depending upon record type of the tag. 

A) Commissioning Dual Record Tag 

Select Lock specified range. and Set Start Section:0,Number of Sections:4 

Click the OK button. 

 

B) Commissioning Single Birth Record Tag 

Select Lock entire memory bank. Click the OK button. 

 

C) Commissioning Single Utility Record Tag 

Select Open for User Memory. 
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4 RFID Label Design and Encoding Management Pro 

Installation 

 

4.1 Install the RFID Label Design and Encoding Management Pro 

 

 Reference: • If the version V01L01R2 of this tool is installed on your computer, it can be 

updated to V01L02R2 using this setup module. Please refer to the "Program 

Update Guide to V01L02R2. - RFID Label Design and Encoding 

Management Pro" for more detailed procedure. 

 

4.1.1 In the Case that the ODBC driver of Microsoft Office is Already Installed 

 

 Operating procedure 

(1) Insert the RFID Label Design and Encoding Management Pro CD into your computer’s 

CD drive. 

(2) Open the root folder of the CD using Explorer, click the “\LDEMP_V01\Module” folder 

and then double-click the "Setup.exe".  

! Caution • If the PC does not have a CD drive, use another PC to copy the 

“\LDEMP_V01\Module” folder to USB memory (or a similar device), and then 

double-click the "Setup.exe" from there. 
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(3) The version (32-bit or 64-bit) of the ODBC driver of Microsoft Office installed on the 

computer is automatically detected and displayed on the screen. Click the Next button. 

 In the case that the 32-bit ODBC drivers are installed. 

 
 In the case that the 64-bit ODBC drivers are installed. 

 
 

! Caution • This tool is only supported for a 64-bit operating system. Even if the installer 

is executed on a 32-bit operating system, this tool would not be installed. 

 



-54- 
Copyright© FUJITSU LIMITED 2017 

 

(4) Select program version (32-bit or 64-bit) of LDEMP, and click the Next. 

 In the case that the 32-bit ODBC drivers are installed. 

 

 In the case that the 64-bit ODBC drivers are installed. 

 

 

! Caution • It is necessary to select same version (32-bit or 64-bit) with ODBC driver 

installed on the computer if Microsoft Office file will be used for data source. 

• If other ODBC drivers will be used, it is necessary to select the same version 

with the ODBC drivers.  
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(5) Click the Install button. 

 

(6) Click the Next button. 
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(7) Click the Install button. 

 

 

(8) Click the Finish button. 

 

 



 

-57- 
Copyright© FUJITSU LIMITED 2017 

 

(9) After the installation completes, click the Finish button. 

 

 

(10) When the installation completes, Fujitsu / RFID Label Design And Encoding 

Management Pro will be registered under the Start / Programs menu. The following 

icon will also be created on the desktop: RFID Label Design And Encoding 

Management Pro. 

Tool Name of the desktop icon 

RFID Label Design & Encoding 

Management Pro 

RFID Label Design And Encoding 

Management Pro 

(11) Remove the setup CD from the PC. 

(12) Restart the PC manually. 

This completes the installation procedure for this tool. 
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4.1.2 In the Case that the ODBC driver of Microsoft Office is not Installed. 

 

 Operating procedure 

(1) Insert the RFID Label Design and Encoding Management Pro CD into your computer’s 

CD drive. 

(2) Open the root folder of the CD using Explorer, click the “\LDEMP_V01\Module” folder 

and then double-click the "Setup.exe".  

 

! Caution • If the PC does not have a CD drive, use another PC to copy the 

“\LDEMP_V01\Module” folder to USB memory (or a similar device), and then 

double-click the "Setup.exe" from there. 
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(3) The message “Any ODBC drivers related to this program were not found on this 

machine” is displayed on the screen. Click the Next button. 

 

 

 

(4) Select program version (32-bit or 64-bit) of LDEMP, and click the Next. 

 

 

! Caution • If other ODBC drivers will be used, it is necessary to select the same version 

with the ODBC drivers.  
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(5) Click the Install button. 

 

 

(6) Click the Next button. 
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(7) Click the Install button. 

 

 

(8) Click the Finish button. 
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(9) After the installation completes, click the Finish button. 

 

 

(10) When the installation completes, Fujitsu / RFID Label Design And Encoding 

Management Pro will be registered under the Start / Programs menu. The following 

icon will also be created on the desktop: RFID Label Design And Encoding 

Management Pro. 

Tool Name of the desktop icon 

RFID Label Design & Encoding 

Management Pro 

RFID Label Design And Encoding 

Management Pro 

(11) Remove the setup CD from the PC. 

(12) Restart the PC manually. 

This completes the installation procedure for this tool. 
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4.2 Manual Feed Settings in BTW Files 

The sample BTW files included in this tool are configured to use the Feed Cartridge as default. If 

using the Manual Feed Slot, please modify the settings in the sample BTW files. 

 

! Caution • If using the Feed Cartridge, please skip this section. 

 

 Operating procedure 

(1) Connect RFID Printer “Zebra ZXP Series 7 (UHF)” with PC using USB cable. 

 

(2) Open the BTW file. 

 Reference: • Sample BTW files for the Commissioning by Barcode Scanning, the Batch 

Commissioning, and the Commissioning from Integrated Sources are stored 

in the following folder. 

C:\Users\Public\RFID Label Design and Encoding Management 

Pro\CommissionData 

• Sample BTW files for the Manual Input are stored in the following folder. 

C:\Users\Public\RFID Label Design and Encoding Management Pro\Manual 

Input\printdata 

 

(3) Select Print… in the File menu. 
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(4) Click the Document Properties… 

 

 

(5) Click the Stock tab and select ‘ATM Slot’ for the Card Setting Source. 
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(6) Click the OK Button. 

 

 

(7) Click the Close Button. 
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(8) Save the BTW file. 

 

 

(9) Close the BTW file. 

 

This completes the setting procedure for the Manual Feed Slot in BTW file. 
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5 Testing 

5.1 Encode and Print a Test Tag 

This section explains you to initiate a test print in order to see if the installation and setup has 

been completed correctly and that everything is working. 

 

! Caution • The ODBC driver of Microsoft Office is necessary to be installed on PC in 

order to perform testing. 

 

 Operating procedure 

(1) To start this tool, click the icon of RFID Label Design and Encoding Management Pro 

that has been placed on the computer desktop. 

 
 

(2) Click the Batch Commissioning button. 
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(3) Click the Work Order button. 

 
 

(4) Select the applicable sample data and click the Select buttton (in this example, we have 

used the Work Order “0002-00001” which is for 8KByte Large tags). 

 

 

 Reference: • Please confirm the applicable Work Order from the following table. 

Record Type Tag Work Order 

Dual 1KByte Large 0001-00001 

Dual 1KByte Medium 0001-00002 

Dual 1KByte Small 0001-00003 

Dual Slim 2Kbit 0001-00004 

Multi 8KByte Large 0002-00001 

Multi 8KByte Medium 0002-00002 

Multi 8KByte Small 0002-00003 

Single Birth Slim 2Kbit 0003-00001 

Single Utility Slim 2Kbit 0003-00002 
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(5) Sample data is displayed on the screen. 
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(6) Select only the first record and click the Commission button. 

 
 

(7) Please wait for the message “Printing data has been successfully transmitted”, then 

insert the tag into the printer. 

 

 

(8) Finish the test printing via the Close button. 

 

If the tag is successfully commissioned, the installation and setup has been completed correctly. 

If not, please contact Fujitsu Customer Support. 
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6 Uninstallation 

6.1 Uninstall the BarTender and Seagull Licensing Server 

This section explains how to uninstall the BarTender and the Seagull Licensing Server. 

 

 Operating procedure 

(1) Select Control Panel, Programs and then Programs and Features from the Start 

menu. 

(2) Select BarTender 10.1 from the Uninstall or change a Program list, and then click the 

Change button. 

(3) Select Remove and click the Next button. 
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(4) Click the Next button. 

 

 

(5) Select “Deactivation Now” and click the Next button. 
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(6) Click the Next button. 

 

 

(7) Click the Next button. 
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! Caution • Need Internet access for this deactivation process. 

• If Internet access is not available on the computer, please do another 

deactivation method according to the instructions on the installation wizard. 

 

(8) Click the Finish button. 
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(9) Uninstallation of the BarTender will start. 

 

 

(10) Click the Finish button. 
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(11) Check that BarTender 10.1 has been deleted from the currently installed programs list.  

(12) Restart the PC manually. 

 

This completes the uninstallation procedure for the BarTender and the Seagull Licensing Server. 
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6.2 Uninstall the BarTender 

This section explains how to uninstall the BarTender. 

 

 Operating procedure 

(1) Select Control Panel, Programs and then Programs and Features from the Start 

menu. 

(2) Select BarTender 10.1 from the Uninstall or change a Program list, and then click the 

Change button. 

(3) Select Remove and click the Next button. 
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(4) Click the Next button. 

 

 

(5) Select “Deactivation Now” and click the Next button. 
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(6) Click the Next button. 

 

 

(7) Click the Finish button. 
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(8) Uninstallation of the BarTender will start. 

 

 

(9) Click the Finish button. 
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(10) Check that BarTender 10.1 has been deleted from the currently installed programs list.  

(11) Restart the PC manually. 

 

This completes the uninstallation procedure for the BarTender. 

 

6.3 Uninstall the ZXP-7 SDK and Printer Driver 

This section explains how to uninstall the ZXP-7 SDK and Printer Driver. 

 

! Caution • Please pull out the USB cable before uninstalling this driver. 

 

 Operating procedure 

(1) Double-click the "C:\Seagull\DriverWizard.exe'". 

 

 

(2) Select “Remove printer drivers”, click the Next button. 
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(3) Select “Remove printers”, click the Next button. 

 

 

(4) Select “Zebra ZXP Series 7”, click the Next button. 
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(5) Click the Finish button. 

 

 

(6) Click the Restart button. 

 

 

 Reference: • Please click the Restart button if this screen is displayed again. 
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(7) After reboot PC, click the Close button. 

 

 

(8) Delete "C:\Seagull” Folder. 

 

(9) Select Control Panel, Programs and then Programs and Features from the Start 

menu. 

 

(10) Uninstall the following three programs. 

- Seagull Install for Zebra ZXP 7 

- Windows Driver Package – FTDI CDM Driver Package  

- Windows Driver Package – FTDI CDM Driver Package  

 

 

This completes the uninstallation procedure for the ZXP-7 SDK and Printer Driver.  
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! Caution • If the ZXP-7 icon remains in the "Device and Printers" after the above 

operation, please right-click the ZXP-7 icon and delete the printer. 

 

6.4 Uninstall the RFID Label Design and Encoding Management Pro 

This section explains how to uninstall the RFID Label Design & Encoding Management Pro 

application. 

 

 Operating procedure 

(1) Select Control Panel, Programs and then Programs and Features from the Start 

menu. 

 

(2) Select RFID Label Design And Encoding Management Pro from the Uninstall or 

change a Program list, and then click the Uninstall button. Click the Yes button. 
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(3) Select RFID LDEMP Installation Tool from the Uninstall or change a Program list, 

and then click the Uninstall button. Click the Yes button. 

 

 
 
 

(4) Check that RFID Label Design and Encoding Management Pro has been deleted from 

the currently installed programs list. 

! Caution • Folders that contain the files created after the installation will not be deleted. 

 • If these folders need to be deleted completely, use Explorer or some other 

file manager to directly delete the "Program Files\Fujitsu\AIT\ 

RFID Label Design and Encoding Management Pro" folder and 

“C:\Users\Public\RFID Label Design and Encoding Management Pro” folder 
and “C:\Users\Public\Public Documents\Fujitsu\RFID Label Design and 
Encoding Management Pro” folder. 

 

(5) Restart the PC manually. 

 

This completes the uninstallation procedure for this tool. 
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